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Foreword

ISO (the International Organization for Standardization) is a worldwide federation of national standards
bodies (ISO member bodies). The work of preparing International Standards is normally carried out
through ISO technical committees. Each member body interested in a subject for which a technical
committee has been established has the right to be represented on that committee. International
organizations, governmental and non-governmental, in liaison with ISO, also take part in the work.
ISO collaborates closely with the International Electrotechnical Commission (IEC) on all matters of
electrotechnical standardization.
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Introduction

On-board computer applications for safety and energy-efficient operations have become popular. These
applications require access to data of shipboard machinery and equipment.

To access data of navigational equipment, a data exchange standard, the IEC 61162 series can be
used. However, access of data from other on-board components and systems (e.g. machinery, safety
equipment and hull) have not yet been standardised.

Exchanging non-standardised data between and/or among applications requires name-based
aggregation and format mapping Haowever, this requires a large amount of lahour, which hinders the

use d

To in
read

facilitate exchange and processing of sensor data from ships.

This
othe
A D3
meas
meta

Data

f such data.

wprove these situations, this document defines unified rules for developing machine
hble identifiers and data structures for shipboard machinery and equipmentfwith the

document defines two concepts and their models for data exchange:-one is Data Char
" is Time Series Data. This document thus defines two distinct data-structures and
ta Channel List, which contains the necessary meta-data, and“a’Time Series Dat3
urements. The time-series format is designed to be lightweight’and it therefore contaq
-data information only in the form of a reference to the channel list.

Channel is a concept that represents virtual data.transmission channels, and d

and human-
objective to

nel, and the
File formats:

format for
ins minimal

bfines time-

invariant properties. Data Channel can be viewed as a stabic description for the different|sensor data
stregms.

Data|Channel is composed of Data Channel ID and Pata Channel Property.

Data|Channel ID uniquely identifies the logical-data channels. Data Channel Property defings attributes
of Ddta Channel.

Ther are three types of Data ChannelhlD: One is Local ID, which is a unique identifier used on-board a
ship,|and another is Universal ID, whieh is a universal identifier, composed of Name Entity, Ship ID (e.g.,
IMO humbers) and Local ID. The dther ID is Short ID, a short alternative ID of Local ID.

The purpose of this documerit is’for exchanging data on-board a ship; however, in the futurg, shipboard
machinery and equipmentmay be connected directly to the Internet.

Thergfore, considering-thie compatibility between Data Channel ID and URLs, which are used to identify
data|on the Internet,“Data Channel ID has a hierarchical structure with slashes as dglimiters. To
repr¢sent a hierarchy, Data Channel is categorised in accordance with the standardised fategorising
rule And named by concatenating these category names with slashes.

In Annexés~B and C, two types of categorising rules and example of codebook, lists of standardised
category names given in accordance with the rules, are defined for reference.

They are not designed to unify Data Channel ID, but it is assumed that some entities will develop,
maintain and manage codebook and that they will be disclosed widely.

Data Channel Property is assumed to be used to automate data processing and help understanding of
data. Data Channel Property shall be used because it is considered to be essential to both computer
applications and humans for the reasons mentioned above.

Time Series Data is a concept that represents collection of time-stamped data. Time Series Data is
assumed to be used for sharing latest data and for analysing trends made over time-stamped data.

For reliable data exchange, this document mandates the use of XML (Extensible Markup Language)
and XML Schema for data encoding and data structure definition. Using XML and XML schemas makes
it possible to define data structures precisely and validate data in accordance with such definitions.

© ISO 2018 - All rights reserved


https://standardsiso.com/api/?name=3564da8819ed6e03e525990efb167d84

ISO 19848:2018(E)

As a result, it is believed that data can be exchanged more reliably between and/or among computer
applications.

Further, for convenience and efficiency, this document also defines data-structures in JSON and
CSV format.

It is assumed that data from shipboard machinery and equipment will be collected by shipboard data
servers, which are defined in ISO 19847. Then, the data encoded in accordance with this document, in
some cases, could be encrypted for security reasons, will be shared between and/or among computer
applications in a wide variety of means, such as in Hyper Text Transfer Protocol (HTTP), in Message
Queue Telemetry Transport (MQTT) or by e-mail through the servers. As described above, external

1: 3 faaa L d Jdos i £ 1 L. 3 1o
Computer apprreatonscatrretreveorooara aata tHrormy Dy actCeSSMgtire-Servers:
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Ships and marine technology — Standard data for
shipboard machinery and equipment

1 Scope

This document applies to the structure of the ship and to shipboard machinery and equipment, and
is intemded forimptententers of Software used for the capture and processing of Sensor data from the
obje¢ts mentioned above.

For those purposes, this document describes the way to name the sensor, required data ifem, and the
way fo describe the data above.

2 Normative references

The following documents are referred to in the text in such a waykthat some or all of their content
constitutes requirements of this document. For dated references,‘enly the edition cited [applies. For
unddted references, the latest edition of the referenced document(including any amendments) applies.

ISO 8601, Data elements and interchange formats — Information interchange — Representafion of dates
and times

ISO/1EC 80000 series, Quantities and units

W3C|XML: Extensible Markup Language (XML) 140, W3C Recommendation
W3C|XML Schema Part 1: XML Schema Part<+Structures, W3C Recommendation
W3C|XML Schema Part 2: XML Schema'Part 2: Datatypes, W3C Recommendation
RFC B339, Date and Time on the Internet: Timestamps

RFC #180, Common Format and MIME Type for Comma-Separated Values (CSV) Files
RFC p234, Augmented BNE for Syntax Specifications: ABNF

3 Terms and-definitions
For the purpgses of this document, the following terms and definitions apply.

ISO gndAEC maintain terminological databases for use in standardization at the following dddresses:

Vasa | 4 q dalal £l L/ 1 i i L
CLICTTTUpPTUIA. avdildUTC dUIILt Y. 77 VW W W.CTCTL T UPCUTA. UT 57

|
5 2]

— ISO Online browsing platform: available at https://www.iso.org/obp

3.1
alert data
information that represents abnormal conditions of shipboard machinery and equipment

3.2
analogue data
numerical information obtained from sensors such as temperature sensors and pressure sensors

Note 1 to entry: Analogue data is a physical value converted from raw electric signals, such as 4-20 mA or 0-5 V.

© ISO 2018 - All rights reserved 1
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3.3
codebook

:2018(E)

list of standardised names

3.4
data

measurement value from shipboard machinery and equipment to which a timestamp is added

3.5

Data Channel
virtual channel for data transmission from shipboard machinery and equipment to shipboard data

server, defi

3.6
Data Chanr
identifier fo

Note 1 to ent

3.7

Data Chann
list of defini
through the

3.8
Data Chann
attributes o

3.9
Data Set
set of Data h

3.10
Extensible
XML
text-based d

3.11
Hyper Text
HTTP
communicat
the Internet

3.12
IMO Numbg
unique refef

H ot i £ 14
llls oLldiiv lJl Ul_ICl LITS Ul'Udtld

el ID
F Data Channel that identifies Data Channel universally and on-board a ship

Fy: There are three types of Data Channel ID: Universal ID, Local ID and Short ID:

el List
fions for Data Channel that define Data Channel ID and Data Channel Property, and is sH
shipboard data server

el Property
F Data Channel, such as units and ranges

aving the same timestamp

Markup Language

ata description language used for exchanging data on the Internet

Transfer Protocol

ion protocol used’to exchange HTML (Hyper Text Markup Language) or other conte

T
ence humber for ships that is given by the International Maritime Organisation (IMO)

ared

Nt on

3.13

logical structure
structure of data that is independent of physical implementation

3.14

measurement value
numeric value or a status symbol, produced as a result of measuring, calculating or estimating the state
of various objects

3.15
metadata
data that de

scribes information about other data
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3.16
Name Object

building block of Data Channel ID used to define the hierarchical structure of Data Channel ID

3.17
Namespace
set of names that is used in order to avoid conflicts of names

3.18
Shipboard Data Server

o«

ship’s “information hub” that stores data from shipboard machinery and equipment, shares data at sea

inclug
Note [l to entry: See ISO 19847 for details.

3.19
shipboard machinery and equipment

variqus systems located in ships machinery space, such as main engine, generator, pumps,
pipelines and electric control systems

3.20
statys data
information that represents the condition of shipboard machinery.and equipment

3.21
Time Series Data
colleftion of a Data Set

3.22
XML(Schema
data|definition language used for XML

4 Abbreviated terms

fans, valves,

ABNF Augmented BackussNaur Form
AMS Alarm Monitoring System

BNF Backus Naur’Form

[AS Integrated Automation System
IMO International Maritime Organisation
HIN Hull Identification Number

HTME Hyper TextMarkup tanguage
HTTP Hypertext Transfer Protocol

RFC Request for Comments

SI The International Systems of Units
URI Uniform Resource Identifier

© ISO 2018 - All rights reserved


https://standardsiso.com/api/?name=3564da8819ed6e03e525990efb167d84

ISO 19848

UTC
UTF-8
XML
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Universal Time Coordinated
UCS Transformation Format 8

Extensible Markup Language

5 Data Channel

5.1 General

Data Chann

Data Chann
Data Chann

5.2 Data
There are tH

Univers

Universal I}

Local ID, me
systems, sug
their own D
to Local ID.

Short ID is 4
short identi

Local ID and
These IDs sh

NOTE D{
Conversely, e

5.2.1 Uni

Universal I}

Local II);
Short ID).

bl is composed of Data Channel ID and Data Channel Property.

bl ID is an identifier for Data Channel, and Data Channel Property represents attribut
],

Channel ID
ree types of Data Channel ID:

] ID;

)

is for identifying on-board Data Channel universally.

anwhile, is for identifying on-board Data Channel locally. For instance, on-board comj]
h as the Integrated Automation System (IASyand the Alarm Monitoring System (AMS),
hta Channel List, which is composed of unique Channel ID. This Channel ID can corres

n optional short alternative identifier of Local ID for usability and data compression.

Short ID shall be unique for a ship.
1all be case-insensitiveto avoid unexpected mistyping.

ta Channel of the“same kind of sensors on different ships is expected to have a same Loc
ven if Data Channel has a same meaning, Short ID may be different for each ship.

yersal ID

isan'URI conforming to the requirements below, in addition to those of the URI defin

The URI def

ier, for instance, can be used.as.Data Channel identifier in the Time Series Data format.

es of

buter
have
pond

This

al ID.

tion.

nition allows for many different compositions, but the Universal ID will be a subset of {

hese

and shall be

in the following format.

Universal ID composition is defined by using Augmented BNF(ABNF), which is defined in RFC 5234, as

follows.
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UniversallD = [protocol] "//" NamingEntity ShipID LocallD
NamingEntity = authority

ShipID = path-element

path-element ="/"unreserved

path-elements = path-element | path-element path-elements

Definition of the “Local ID” element is mentioned in 5.2.2.

" element is

ters, such as

reserved are

Local ID.

bther means

The [authority” and “unreserved” element is defined in the URI definition. The “protocol
optidnal.
NOTE1 Though path element of URI that is defined in RFC 3986 accepts muchymore charag
RFC B986 “sub-delimiters”, “”, “@”, etc., this document only accepts RFC 3986 “Unteserved” characters since
these characters may be used as control character in ISO 19847. (Definition of sub-delimiters and u
defingd in RFC 3986).
The §lash (“/”) is a reserved character for describing hierarchies,
a) Naming Entity
Naming Entity element shall be a domain owned or conttolled by the entity producing
EXAMPLE
1+ data.shipdatacenter.jp
1+ data.dnvgl.com
b) $hipID
$hip ID is for identifying ships universally.
Usually, an IMO number or'HIN should be used for Ship ID.
If ships have no IMO number or HIN, an identifier provided by countries or regions, or
may be used insteads-
EXAMPLE
+ /IMO1234567
+ /JP-HXAB7A33G293
5.2. Local ID

Local ID consists of Naming Rule and Local Data Name.

Local ID composition is defined by using ABNF as follows

© ISO 2018 - All rights reserved
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LocallD = NamingRule LocalDataName

NamingRule = path-element

LocalDataName = path-elements

path-element ="/"unreserved

path-elements = path-element | path-element path-elements

a) NamingRule
Naming Rule shall be the designated name for the rule used to name Data Channel.

This name can be set freely under the supervision of Naming Entity, and shall have.a’symbol that
represepts Naming Entity in front to eliminate duplications.

A Namihg Rule is a set of requirements that define a naming scheme (or an(identification scheme)
for components and systems on-board the ship. A Naming Rule shall define how identificption
strings pre composed, and the method of developing an identification string.

EXAMPLE
— /jsmea_mac
— /dnygl-vis

b) Local Data Name
Local Data Name is an identifier for Data Channel-that is named in accordance with Naming Rule.
The syntax of the identification string shall be disclosed and precisely defined using ABNF.
EXAMPLE
— /MdinEngine/Cylinder1/ExhaustGas/Temp
— /41].1/C101.31+1/ExhGas+t(C)

5.2.3 ShortID

Short ID is|an optional short alternative to Local ID. There must be a one-to-one correspondence
between Data Channel@aind Short ID; Short ID shall therefore be unique for a ship.

Definition of ShortdP is as follows.

ShortID = unreserved

Short ID shall be as short as practical and represented as machine-friendly symbols, human-friendly
short word, or a combination of those symbols and short word.

EXAMPLE
— 0001
— TAHO001
— ME_RPM

6 © ISO 2018 - All rights reserved
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5.2.4 Example of Data Channel ID

In the following example, Ship ID, Naming Rule and Local Data Name will be understood as the above
definition, but without the leading slash.

Universal ID

http://data.shipdatacenter.jp/imol1234567/jsmea

mac/MainEngine/Cylinder1/ExhaustGas/Outlet/Temp

Local Data Name

Local ID /jsmea_mac/MainEngine/Cylinderl/ExhaustGas/Outlet/ Temp

Short ID 0001

Ship ID imo1234567

Nanming Entity data.shipdatacenter.jp QN
Naning Rule jsmea_mac

Local Data Name  MainEngine/Cylinderl/ExhaustGas/Outlet/Temp ‘Q.;‘.V
Uniyersal ID http: .dnvgl.com/imo1234567/dnvgl-vis/41}:1/€101.31+1/ExhGas+t(C)
Local ID /dnvgl-vis/411.1/C101.31+1/ExhGas+t(C)

Short ID 0001 <

Ship ID imo1234567

Nanping Entity data.dnvgl.com i ‘\\\\

Naning Rule dnvgl-vis

411.1/C101.31+1/ExhGas+t(C) 5

NOTE 1
valid|URL.

5.3

It is not a requirement that the UniversallID be a resolvable UR], i.e., the URI is not

Data Channel Property

Data|Channel Property shall be defined to provide the attributes of Data Channel.

The teserved property types.are as follows.

— Data Channel Type

— Format
Range

—  Unit

Duality Coding

hecessarily a

Name

Remarks

The properties above shall be described in accordance with the rules in this Clause.

Properties that are not listed above may be used if these are clearly distinguished from the properties
defined in the standard.

Details of each property are as follows.

a) Data Channel Type

Data Channel Type is used to identify the types of Data Channel, such as row numeric value, average
value, alarms and status. Data Channel Type is composed of the following sub-properties.

© ISO 2018 - All rights reserved
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— Type
— Update Cycle
— Calculation Period

Type sub-property defines type of Data Channel and the value of the property follows the definitions
mentioned in Table 1.

Table 1 — Type name of Data Channel Type

Ype Description
Inst Measuring value at a certain point in time.
Average Average of the value within a certain time period.

"Average" does not mean average of values from multiple sensors atthe same|time
but average of time-series values from single sensor.

Max Maximum value within a certain time period.

"Maximum" does not mean maximum of values from multiple sensors at the §ame
time but maximum of time-series values from single sénsor.

Min Minimum value within a certain time period.

"Minimum" does not mean minimum of valueg fiom multiple sensors at the §ame
time but minimum of time-series values from¢ingle sensor.

StandardDeyiation Standard deviation of the value within a cértain time period.

"StandardDeviation" does not mean stafidard deviation of values from multiplq sen-
sors at the same time but standard déviation of time-series values from single sensor.

Calculated Value obtained from calculatiopinstead of measurement.
SetPoint Target value for automatic control.

ControlOutpjut Manipulated value of automatic control.

Alert Alarm values that canbe obtained are also described.

Status Status values that'ean be obtained are also described.
ManuallyIngut Value input by-crew. Value assumed here is reading of indicator.

b)

Update Cycle represents the cycle of updating measurement value. This sub-property shall be|used
when mleasurement value is ‘updated periodically.

When ajvalue of Data Chiafinel is a result of calculation that uses measurement value of specific|time
periods| CalculationPeriod shall be used to describe the said period.

Update [Cycle and Calculation Period shall be described with a decimal number that is larger|than
zero. The unit'@f'Update Cycle and Calculation Period shall be the “second”.

Type sur:)-property is mandatory and the others are optional.

EXAMPLES

—  Type Average
— Calculation Period 60

— Update Cycle 1
Format

Format is used for describing data formats and defined by the following sub-properties.

— Type

— Restriction

© ISO 2018 - All rights reserved
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Type sub-property is mandatory and Restriction sub-property is optional. More than one
Restriction sub-property may exist under the Format property.

Available Types are as follows. Definitions of these data types comply with W3C XML Schema
Definition Language (XSD) 1.1 Part 2: Datatype.

Table 2 — Available Datatype for Format property

Type

Description

Decimal

Decimal represents a subset of the real numbers, which can be represented by
decimal numerals. The value space of decimal is the set of numbers that can be

obtained by dividing an integer by a non-negative power of ten, i.e,.ekpressible as

i / 10n where i and n are integers and n 20. Precision is not refleetéd
space; the number 2.0 is not distinct from the number 2.00. The orde

decimal is the order relation on real numbers, restricted to-this’subs¢t.

in this value
r relation on

Integer

Integer is-derived-from decimal by fixing the value of fsaction digitj

to be 0 and

1,0,1,2,...}. The base type of integer is decimal.

disallowing the trailing decimal point. This results in(the’standard rII:athematical
concept of the integer numbers. The value space of integer is the infin

ite set {...,-2,-

Boolean

Boolean represents the values of two-valuedogic.

String

The string datatype represents charactey strings in XML.

Datglime

YYYY indicates the year

MM indicates the month

DD indicates the day

T indicates the startof the required time section
hh indicates the hour

mm indicatesithe minute

ss indicates the second

Z indjeates UTC

Date and time data types are used for¥alues that contain date and tine.
Format shall follow ISO 8601 "YYYY-MM-DDThh:mm:ssZ" where:

Table 3 — Restrictions for Format property

Following restrictions\defined in W3C XML Schema are available to define acceptable values.
Validation rules and-available constraint for each data types shall follow W3C XML Schema.

Restrictign Description Data Type
Enutneratioh Defines a list of acceptable values. string
FractienDigits Specifies the maximum number of decimal places allowed.| nonNegativelntgger
Must be equal to or greater than zero
Length Specifies the exact number of characters or list items allowed. | nonNegativelnteger
Must be equal to or greater than zero.
MaxExclusive Specifies the upper bounds for numeric values (the value must| A value from the -value space-
be less than this value). of the {base type definition}.
MaxInclusive Specifies the upper bounds for numeric values (the value must| A value from the -value space-
be less than or equal to this value). of the {base type definition}.
MaxLength Specifies the maximum number of characters or list items|nonNegativelnteger
allowed. Must be equal to or greater than zero.
MinExclusive Specifies the lower bounds for numeric values (the value must| A value from the -value space-
be greater than this value). of the {base type definition}.
MinInclusive Specifies the lower bounds for numeric values (the value must| A value from the -value space-

be greater than or equal to this value).

of the {base type definition}.

© ISO 2018 - All rights reserved
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Table 3 (continued)

Restriction Description Data Type
MinLength Specifies the minimum number of characters or list items|nonNegativelnteger
allowed. Must be equal to or greater than zero.
Pattern Defines the exact sequence of characters that are acceptable. | string
TotalDigits Specifies the exact number of digits allowed. Must be greater | positivelnteger
than zero.
WhiteSpace Specifies how white space (line feeds, tabs, spaces, and car-

riage returns) is handled.

d)

10

EXAMPLES

—  Type Decimal

— Resgriction TotalDigits 8, FractionDigits 3
Range
Range i$ for describing Data Range. Range property is composed of thefollowing sub-properties.
— Low
— High

Low sub-property represents lower limit of the analogue data, and High sub-property represents
its uppqr limit.

The valyie type of these sub-properties is decimalvalue or empty. The value of these sub-propdrties
can be gmpty only if lower and/or upper limit cahnot be specified.

Further} High value must be greater than aid not equal to Low value.
Range droperty is mandatory only of the analogue data.

NOTE Range does not mean upper and lower boundary of the value. The value can exceed the rajge in
case of sensor failure or other abnerial condition.

EXAMPLES
— Low O
— High 120
Unit

Unit deflines the unit and quantity applied to the measurement value. Unit property is composed of
the following sub-properties.

— Unit Symbol
— Quantity Name

Unit symbols and quantity names defined in ISO 80000 or Table 4 shall be used for Unit Symbol and
Quantity Name sub-properties.

Unit Symbol sub-property represents unit symbol of the measurement value (e.g., “m” for length
and “kg” for mass). The value of Unit Symbol sub-property can be empty only for non-dimensional
quantities.

Quantity Name sub-property may be used to identify the variable that is measured or computed for
the physical item defined by the Data Channel.
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The measurement value shall be described according to the Unit defined in this property.

NOTE On-board computer applications (Data consumer) can convert Unit according to ISO 80000.
EXAMPLES
— Unit Symbol kW
— Quantity Name active power
— Unit Symbol Pa
— Quantity Name pressure
Table 4 — Additional units and quantities of measurement yalue
Quantity Name Unit Symbol Remarks
Cargo capacity TEU Twenty-foot Equivalent Unit
FEU Forty-foot Equivalent Unit
e) Quality Coding
Duality Coding represents a name of data quality evaluation‘Scheme and the scheme shall be able to
dlistinguish at least between valid and invalid measurement values of the Data Channel].
EXAMPLES
+ "OPC-QUALITY".
. "IEC 61162-STATUS".
In the case of "IEC 61162-STATUS", A" (Data valid) and "V" (Data invalid) are used ffor the data
uality.
f) ame
ame can be used to describe names assigned for on-board control systems and other instruments.
XAMPLE
“Main Engine®evolution”.
g) Remarks
n Remarks, arbitrary complementary information on Data Channel is described.
erharks should include locations, manufacturers and types of equipment.
EXAMPLE
— “Location: ECR, Manufacturer: AAA Company, Type: TYPE-AAA”.
6 Time Series Data
6.1 General

Time Series Data is a collection of measurement values in which all the values have a corresponding
time of measurement. Usually such data is arranged and recorded in chronological order.

© ISO 2018 - All rights reserved
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6.2 Type of Time Series Data

For practical purposes (efficient data transport), two distinct representations of Time Series Data are

defined:
— Tabular Data;

— Event Data.

These representations are used depending on update interval of measurement values.

6.2.1 TabularData

Tabular Datp is a vector of a fixed number of values expected to be reported at regular interval.

Channel List defines the interval.

Some examples of Tabular Data are:

— multipl¢ raw numeric values from sensors/transmitters sampled at the same-time;

— result of the calculation (e.g. time average, standard deviation, etc.) to be‘performed regularly

Measurement values are grouped per timestamp, thus Tabular Data fornis like Table 5.

Table 5 — Example of Tabular Data

Time Stamp Data Channel 1 | Data Channel 2| Data Channel 3 | Data Channel 4
2017-01-01T00:00:00Z 101.2 0.30 10.2 CLOSE
2017—¢1-01T00:00:012 0.0 0.30 10.2 CLOSE
2017-01-01T00:00:02Z 1109 0:32 10.2 OPEN

6.2.2 Event Data

Event Data ifs a collection of data for which-the number of values at a specific time is not fixed.

Some exam‘p[les of Event Data are:

— alarm information;
— status information;

— manually input datat

Event Data fypically-forms in tabular form like Table 6:

Table 6 — Example of Event Data by tabular form

Time Stamp Data Channel 1 | Data Channel 2 | Data Channel 3 | Data Channel 4
2017-01-01T00:00:00Z 101.2 — — —
2017-01-01T00:00:01Z — — — —
2017-01-01T00:00:027Z 1109 0.32 — OPEN

Data

Tabular form mentioned above is not efficient for Event Data, thus measurement values are grouped per
both timestamp and Data Channel ID and forms like Table 7:

12
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Table 7 — Example of Event Data

Time Stamp Data Channel ID Value
2017-01-01T00:00:00Z Data Channel 1 101.2
2017-01-01T00:00:02Z Data Channel 1 1109
2017-01-01T00:00:02Z Data Channel 2 0.32
2017-01-01T00:00:02Z Data Channel 4 OPEN

6.3 Time Series Data Composition

Each|{row of Tabular/Event Data is called Data Set.

Tabullar Data is composed of a collection of Data Set without Data Channel IDs, since value can be
identified by its order.

Tabullar Data of Table 5 is described as follows.

DataSet("2017-01-01T00:00:00Z","101.2","0.30","10.2","CLOSE")
DatpSet("2017-01-01T00:00:01Z","0.0","0.30","10.2","CLOSE")
DatSet("2017-01-01T00:00:02Z","110.9","0.32", "10.2","OPEN"Y)

Evenft Data is composed of a collection of Data Set with Data Channel ID, since a number of values at a
specific time cannot be fixed.

Evenlt Data of Table 7 is described as follows.

DatSet("2017-01-01T00:00:00Z ", "DataChannell”, "101.2")
DatSet("2017-01-01T00:00:02Z ", "DataChannel1”, "110.9")
DataSet("2017-01-01T00:00:02Z "; "DataChannel2", "0.32")

DatSet("2017-01-01T00:00:02Z ", "DataChannel4”, "OPEN")

7 Data structure

7.1 | General

Data|structure’is the definition of logical structures that are independent from data implementation
langfiagesysuch as XML, JSON, CSV and others.

Th Claiicn dafinmac tuagn g oFf Aot cbsnaindbaien N 3o £o Mot Chon Al T o +h o 1ot A fF t Ch 1
IS UIdUuoLU ULlTITICOS LVWU Lyl.l\';) Ul udtda Structiurtc. UIIU 101U DUdltd UlIIdIITIICI LIoL, UIIC 115U Ul a a anne

definitions in Clause 5, and the other is for serialisation and transport of Time Series Data in Clause 6.

These structures can be described by using XML, JSON and CSV.

In addition, standard data type, which is used to define the data structure and also independent of
implementation languages, is defined.

Standard data type can be replaced with the data types defined in the implementation language.

Data implemented in accordance with the data structure can be shared between and/or among
computer applications.
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7.2

Implementation language

Data structure defined in this Clause shall be implemented in accordance with Annex A.

7.3 Standard data types

To define the data Structure, the following standard data types derived from UML primitive types
listed in Table 8 are used.

Table 8 — Standard data types

Standard|data type Primitive type Restriction Remarks

Integer Integer

NonNegativ¢Integer Integer larger than -1

Positivelnteger Integer larger than 0

Real Real

Boolean Boolean

String String

DateTime String formatted by Refer to RFC3339 for ABNF expression.

ISO 8601
Null Null specitiesthe lack of a value (can be usdd for
any datatypes).

7.4 Strugture of Data Channel List

7.4.1 Data model

Data Channel List shall consist of the following five'€lements.

a) Packagd
Package is a data package that is mdde ‘up of Header, which is a set of metadata, and DataChannel,
which ig a main data body.

b) Header
Header [indicates when Data Channel List is created and who creates it.

c¢) DataChannel
DataChgnnel consists of Property and DataChannelld, which indicates Data Channel definitions.

d) DataChannellD

DataChannellD 1s an 1dentiiier of Data Channel defined 1n 5.2.

e) Property

Property defines the attributes of Data Channel defined in 5.3.

These elements are arranged in the hierarchic structure shown in Figure 1.

14
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Package

¢

1
Header

DataChannelList

7.4.2

Data|Channel List shall have the logical strueture shown in Figure 2.

Data

DataChannelList element. The DataChannelList element includes one or more DataChany
with|its IDs and properties.

Further, NameObject elemerit may be added to define structure of Local ID.

L DataChannel

0.*
K

DataChannellD

Property

1

Figure 1 — Model of Data Channel List

Logical structure

Channel List has a Package element. The Package element is composed of a He

ader and a
1el elements
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Package

Header: Header[1]
DataChannelList: DataChannelList{1]

Header Referenced by ConfigurationReference te
ShipID: String[1] TimeSeriesData.
DataChannelListID : ConfigurationReference[ 1 ConfigurationReferenceis consistIDand
Author: String{0..1] L TimeStamp element.
DateCreated : DateTime[0..1] ol - —
————— Value "DateCreated" is strings that comply
i Twimlsosaol format.
: ConfigurationReference
1D String[1]
TimeStamp : DateTime[1]

I DataChannelList

Loy

DataChannel

DataChannelID: DataChannellD[1]
Property: Property[1]

DataChannellD
L _> LocallD : Stringf1]
ShortID: String[0..1]

NameObject: NameObject[0..1

|
| NameObject

Tz NamingRule:String[1]

Property

DataChannelType: DataChannelType[1]
——> Format: Format{1]

Range: Range[0..1]
Unit: Unit{0..1]
QualityCoding: String{0..1]
Name: String]0..1]
Remarks: String[0..1]
DataChannelType
| _> Type: String{1]
UpdateCyde: Real[0..1]
CalculationPeriod : Real[0..1
Format
= Type: Sting[1]
Restriction: Restriction|0..1]

Restriction

|

i

! Enumeration : Sring[0. ]

: FractionDigits: Integer{0..1]{value>-1}
|

|

|

|___> MaxLength : Integer{0..1{value>-1}
MinExdusive: Real[0..1]

MinIndusive:: Real[0..1]

MinLength : Integer{0..1{value>-1}

Pattem: String[0..1]

TotalDigits : Integer{0..1]{value>-0}

WhiteSpace : WhiteSpace[0..1]

Range

T ow:Real[1] ]| Valueof High/Lowelement
High: Real[1] *f~~~"]canbeempty.

Unit

> UnitSymbol:String[1] _ e}~———{ Valueof Unitelement
QuantityName: String[0..1] canbeempty.

Figure 2 — Logical structure of Data Channel List

Details of each element are described below.

a) Package structure

Name Data type Note Mandatory/ | Max

Option count
Header b) Header See b). Mandatory 1
DataChannelList d) DataChannelList See d). Mandatory 1
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Name Data type Note Mandatory/ | Max
Option count
ShipID String See 5.2.1. Mandatory 1
DataChannelListID c) ConfigurationReference See c). Mandatory 1
Author String Author of Data Channel |[Optional 1
List.
Datg€reated DateTime Datewhen Package 15— [Ooptionat 1
created.
c) ConfigurationReference structure
Name Data type Note Mandatoly/ | Max
Option count
ID String Identifier of Data Channlel | Mandatory 1
List itself.
TimgStamp DateTime Modified Date & Time. Mandatoryj 1
d) DataChannelList structure
Name Data type Note Mandatory/ | Max
Option count
DataChannel e) DataChannel See e). Mandatoryj *
e) DataChannel structure
Name Data type Note Mandatory/ | Max
Option count
DataChannellD f) DataChanneldlD See f). Mandatory 1
Property g) Property See g). Mandatoryj 1
f) DPataChannellD structure
Name Data type Note Mandatoly/ | Max
Option count
LocdlID String See 5.2.2. Mandatory 1
ShontID String See 5.2.3. Optional 1
NamleObject m) NameObject Definition of Local Data Optional 1
Name structure.
g) Propertystructure
Name Data type Note Mandatory/ | Max
Option count
DataChannelType h) DataChannelType See h) and 5.3 a). Mandatory 1
Format i) Format Seei)and 5.3 b). Mandatory 1
Range k) Range Seek)and 5.3 ). Mandatory* 1
Unit 1) Unit Seel) and 5.3 d). Mandatory* 1
*  Range and Unit are required only when Data Channel Type is “Decimal”.
© ISO 2018 - All rights reserved 17
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Name Data type Note Mandatory/ | Max
Option count
QualityCoding String 5.3e). Optional 1
Name String See 5.3f). Optional 1
Remarks String See 5.3 g). Optional 1
*  Range and Unit are required only when Data Channel Type is “Decimal”.
h) DataChannelType structure
Name Data type Note Mandatory/ | Max
Option count
Type String Described in accordance Mandatory 1
UpdateCvecl Real with Data Channel Type Optional 1
pdateLyce ca format shown in 5.3 a). ptiona
CalculationBeriod Real Optional 1
i) Formatfstructure
Name Data type Note Mandatory/ lllax
Option cqunt
Type String Described in accordafice Mandatory 1
Restriction j) Restriction }/Z)lrtn};:?tastl?o%\}/lr?rilr?gl;;‘}g)).e Optional 1
i) Restfriction structure
Name Data type Note Mandatory/ lllax
Option cqunt
Enumeration String Described in accordance Optional *
FractionDielt Int with Data Channel Type for- [ 0041 1
ractionDigits nteger mat shown in 5.3 b) Table 3, ptiona
Length Integer Optional 1
MaxExclusivie Real Optional 1
MaxInclusivg Real Optional 1
MaxLength Integer Optional 1
MinExclusivp Real Optional 1
MinInclusivq Real Optional 1
MinLength Iateger Optional 1
Pattern String Optional 1
TotalDigits Integer Optional 1
One of the following: Optional 1
“Preserve”
WhiteSpace
“Replace”
“Collapse”
k) Range structure
Name Data type Note Mandatory/ | Max
Option count
Low Real Lower limit of measuring range. Mandatory 1
High Real Upper limit of measuring range. Mandatory 1
18 © ISO 2018 - All rights reserved
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Name Data type Note Mandatory Max
/Option count
: . Unit symbol defined in ISO 80000 or
UnitSymbol String 5.3 d) Table 4. Mandatory 1
QuantityName Crring Quantity name defined in ISO 80000 or |, .. . 1
7 ® 5.3 d) Table . P
m) INameObject structure
Name Data type Note Mandatory/ | Max
Option count
NamjingRule String See 5.2.2 Mandatoryj 1
7.5 | Structure of Time Series Data
7.5.1 Data model
Timg Series Data shall consist of the following elements.
a) Irackage
ackage element is data made up of a Header;which is a metadata, and TimeSeriesDatp, which is a
ain data body.
b) Header
eader element contains the nécessary metadata to link the Data in the Package fo the right
hannels in the Data Channel List and the time in the real world.
his can be achieved by indicating when Time Series Data is created, who creates Time|Series Data,
n explicit reference to a-specific Data Channel List, what Data Channels are included,|the number
f data and the measuréement period of Time Series Data.
If such kind of metfadata is shared in advance by any means, Header element itself may be omitted
r just formedby list of Short IDs.
c¢) TimeSeriesData

TimeSeriesData element is a main body of the Package and contains Time Series Dat]
(lause 6.

A defined in

TimeSeriesData element also represents a group of DataSet and is grouped by Data Channel List
editions. Once Data Channel List is updated and the updates will affect the value of Time Series
Data, this element shall be newly generated.

d) TabularData

TabularData element contains a list of values defined in 6.2.

Tabular means that an ordered list of measurement value that is reported with the same timestamp
and the same update interval.

TabularData shall be grouped by the update interval.

© ISO
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e) EventData

EventData element contains a list of (typically) irregularly updated values where a reference to the
Data Channel List (LocalID or ShortID) is given for each data point (see 6.2 for details).

(6) DataSet

DataSet is a set of measurement values having the same timestamp. There are two types of DataSet,
one is for TabularData, and the other is for EventData.

These elements are arranged in the hierarchic structure shown in Figure 3.

Package

1

$

Header

0.1

TimeSeriesData

1.* ‘

TabularData
0.*
1
DataSet
0.*
EventData
0.* ‘
1
DataSet
0.*

Figure 3 — Model of Time Series Data

7.5.2 Log

1cal structure

Time Series Data shall have the logical structure shown in Figure 4.

Time Series Data has Package. Package has Header and TimeSeriesData. TimeSeriesData includes one
or more DataSet. DataSet has one TimeStamp and one or more Data.

20
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Package

Header : Header[0..1]

TimeSeriesData : TimeSeriesData[1..*]

Header

ShipID : String[1]

ISO 19848:2018(E)

One of these should be included
under TimeSeriesData element.

TimeSpan : TimeSp;{n[O..l] Describe DateTime in accordance with ISO8601.Note that [N
DataCreated : DateTime[0..1] definition of Date Time in XML Schema specification
DateModified : DateTime[0..1] references 1ISO8601.
Author : String[0..1]
SystemConfiguration : ConfigurationReference[0..*]
11 Reference to System configuration, such as OS, RDBMS. [N
If there is no SJlstemConfiguration element, the latest one
should be used.
TimeSpan
~ A Start: DateTime[1] __ N
End: DateTime[1] e4—___] Describe DateTime in accordance with ISO8601. Not(B
~77 definition of Date Time in XML Schema specificatio;
references 1S08601. '\
AN
TimeSeriesData When DataChannelList is modified, ne "*‘@geriesData” AN
_| element will be created.
DataConfiguration : ConfigurationReference[0..1] @-+——"| If there is no DataConfiguration el , the latest one shpuld
TabularData : TabularData[0.*] be used. @
EventData : EventData[0..1] '\
"TabularData" elem¢nts are
ﬁ» _____ TabularData grouped per update|Interval.
- NumberOfDataSet : Integer([0..1]{value>-1} B
\\\ NumberOfDataChannel : Integer[0..1]{value>-1}
\\ DataChannellD : String[0..*] .
N D :D Tabular[0.* N
N ataSet: DataSet _Tabular[0.] ~ Order of DathChannelID
N ~~~_|and Value arfay should
N be the same.
AN Otherwise, | feference No.
AN DataSet_Tabular shall be adddd to each
AN element of
o @ TimeStamp : DateTime[1] ~1DataChannelfD / Value
AN TimeStal ~"| Value: String[1.*] e| |array.
\\ must&u que. Quality : String[0..1]
N o
\\\ \\\\
N\, \\
EventData =
Grouped per|TimeStamp

NumberOfDataSet : Integer[0..1]{value>-1}
DataSet : DataSet _Event[0..¥]

ConfigurationReference DataSet_Event Grouped per] TimeStamplj
" ~71and DataChapnellD
ID : String[1] TimeStamp : DateTime[1]
TimeStamp : DateTime[1] DataChannellD : String[1]
Value : String[1]
Quality : String[0..1]
Figure 4 — Logical structure of Time Series Data
Detajls of each element are as follows.
a) PacKage structure
Name Data type Note Mandatory/ | Max
Option count
Header b) Header See b). Optional 1
For periodic data exchange,
this element can be omitted to
reduce data size.
TimeSeriesData e) TimeSeriesData See e). Mandatory  |*

TimeSeriesData is grouped by
DataChannelList editions.

© ISO 2018 - All rights reserved
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b) Header structure

Name Data type Note Mandatory/ | Max
Option count
ShipID String IMO number, HIN, etc. Mandatory 1
TimeSpan c) TimeSpan See c). Optional 1
DateCreated DateTime Date when Package is created. |Optional 1
DateModified DateTime Date when Package is modified. |Optional 1
Author String Author of data. Optional 1
SystemConfiguration d) ConfigurationReference | See d). Optional *
Reference to the configuration of
systems, such as OS, RDBMS, etc.
c¢) TimeSphn structure
Ngme Data type Note Mandatory/ | Max
Option count
Start DateTime Timestamp of the oldest Data Mandatory 1
Set.
End DateTime Timestamp of thesnéwest Data | Mandatory 1
Set.
d) ConfigurationReference structure
Ngme Data type Note Mandatory/ ]Ilax
Option count
ID String Identifier of the configuration. |Mandatory 1
TimeStamp DateTime Modified date & time of the Mandatory 1
configuration.
e) TimeSeriesData structure
Ngme Data type Note Mandatory/ | Max
Option count
DataConfiguration d)-ConfigurationReference | See d). Optional 1
Reference to the DataChannel-
List.
If there is a no reference, the
latest DataChannelList shall be
used.
TabularData f) TabularData See f) and Clause 6. Optional *
EventData g) EventData See g) and Clause 6. Optional 1
22 © IS0 2018 - All rights reserved
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Name Data type Note Mandatory/ | Max
Option count
NumberOfDataSet NonNegativelnteger Number of DataSet in the Tabu- |Optional 1
larData element.
NumberOfDataChannel |NonNegativelnteger Number of DataChannel in the |Optional 1
TabularData element.
DataChannellD ering Array of one of the Data Channel ﬂp‘rinnnl *
ID in 5.2.
Order of DataChannellD ele-
ments shall be same as f) Tabu-
larData/Value.
If the order of DataChannellDel
ements cannot be specified, ref-
erence number shall be added.
Further, If the ordet of Data-
ChannellD elements can be fixed
and never changed, these ele-
ments maybe.omitted.
DataSet h) DataSet_Tabular See Clause 6. Optional *
g) [IventData structure
Name Data type Note Mandattlry/ Max
Optio| count
NuniberOfDataSet NonNegativelnteger Number of DataSet in the Event- |Optional 1
Data element.
DataSet i) DataSet_Eyent See 6.3 b). Optional *
h) DataSet_Tabular structure
Name Data type Note Mandattlry/ Max
Optio count
Timgstamp DateTime Time of measurement. Mandatofy 1
Valug String Array of measurement value of |Mandatofy  |*
each data channel at TimeStamp.
Order of Value elements shall be
same as f) TabularData/Data-
ChannellD.
If the order of Value elements
cannot be specified, reference
number shall be added.
Quality String Data quality of the Value above. |Optional 1
i) DataSet_Event structure
Name Data type Note Mandatory/ | Max
Option count
Timestamp DateTime Time of measurement. Mandatory 1
DataChannellD String One of the Data Channel ID in 5.2.| Mandatory 1
Value String Measurement value. Mandatory 1
Quality String Data quality of the Value above. |Optional 1
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Annex A
(Normative)

Implementation

A.1 General

A.1.1 Exc
Data which
Regardless
Data sh

XML/JSON
(*: contains

hanging Data

have structure as written in Clause 8, will be implemented by XML, JSON or GSV:
f the implementation language, data shall comply as follows.

hll be written by text and encoded by UTF-8 WITHOUT Byte Order Mark (BOM).

s recommended to exchange Data Channel List and snap shet(*) of Time Series

Data

single Data Set or a few number of Data Sets). When usingJSON, since there is no schema

validation mhechanism, it is recommended to develop applications<{wjith an environment that can

communicate with actual shipboard data server. CSV is recomménded for especially large [[ime

Series Data.|In this case, Data Channel List shall be shared in advance. XML/JSON is recommended for

exchanging Data Channel List.

A.1.2 Exchanging data as a file

The data fil¢ shall be designed to be able to process in"various file systems.

To do this, the file shall comply with the following-requirements.

— The narpe of the file shall be case-insensitive.

— The name of the file shall not start¥ith “” (period).

— The narpe of the file shall notcontain [\ ] [/T[:1[*]1[?]1["1[<1[>11]]andany white 4pace
charactgrs.

— The length of the name-gfthe file shall be less than or equal to 255 characters.

A.2 XMLjimplementation

A.2.1 General

In this Clause, requirements are shown of cases in which the data formats discussed in Clause 7 are

implemente

d with the use of XML and XML Schemas.

XML Schema is formulated in accordance with the rules described below.

EXAMPLE

24

The minimum and maximum numbers of occurrences shall be defined.

<nr:NamingRule nr:ID="Naming_Rule"/>

Naming Rule specific elements and attributes should belong to its own Namespace.

Any newline or indent characters in the file shall not be treated as significant information.

XML Schema shall be created to command XML to add Namespace to all elements and attributes.
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A.2.2 Standard & XML Schema data type
Standard data type in 7.3 is replaced with XML Schema data type in Table A.1.

Table A.1 — Correspondences between standard data type and XML Schema data type

Standard Data Type XML Schema Data Type Note

Integer Integer Integer number

Positivelnteger Positivelnteger Integer number thatis 1 or larger

NonNegativelnteger NonNegativelnteger Integer number thatis 0 or larger

Real Decimal Decimal number

Datel'ime DateTime [SO 8601 time and date

CharjacterString String Random string of characters

Boolean Boolean Truth value

Null XML Schema When designating Null, designate Attribute
<element name="example" tvpe="float" nillable="true” in the Element|definition of
nillable="true" ; p ype= XML Schema,and Attribute nillgble="true” in

- the corresponding Element in XML Document.

XML Document
<example nil="true"/>

A.2.3 Data Channel List
a) INamespace

[he following Namespace shall be added to allthe elements and attributes in Data Chapnel List.
XMLNamespace:sdd = urn:1S019848:Ship, Data_Definition
In case of using Naming Rule specific elements/attributes, namespace shall be to avoid|duplication.
EXAMPLE XMLNamespace:nt =drn:1S019848:Ship_Data_Definition:Naming_Rule
b) XML Schema

Data structures in 7.4-shall be defined and validated by using following XML Schema.

<?xmfl version="1.0"-&ancoding="utf-8"?>

<xs:pchema xmlns i sdd="urn:I15S019848:SHIP_DATA DEFINITION"
attrdbutfeFormDefault="unqualified" elementFormDefault="qualified"
tangetNamespace="urn:15019848:SHIP DATA DEFINITION"
xmins:xs="http://www.w3.0rg/2001/XMLSchema">

<!'t-7,452" a) Package structure-->
<xpi€lement name="Package" type="sdd:Package"/>

<!--7.4.2 a) Package structure-->
<xs:complexType name="Package">
<xs:sequence>
<!--7.4.2 b) Header structure-->
<xs:element name="Header" type="sdd:Header" minOccurs="1" maxOccurs="1"/>
<!--7.4.2 d) DataChannellist structure-->
<xs:element name="DataChannellList" type="sdd:DataChannellList" minOccurs="1"
maxOccurs="1"/>
</xs:sequence>
</xs:complexType>

<!--7.4.2 b) Header structure-->
<xs:complexType name="Header">
<xs:sequence>
<!--IMO Number, HIN or other ship's identification number-->
<xs:element name="ShipID" type="xs:string" minOccurs="1" maxOccurs="1"/>
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<!--Identifier of this list-->

<xs:element name="DataChannelListID" type="sdd:ConfigurationReference"
minOccurs="1" maxOccurs="1"/>

<!--Author of data-->

<xs:element name="Author" type="xs:string" minOccurs="0" maxOccurs="1"/>

<!--Date when data are created-->

<xs:element name="DateCreated" type="xs:dateTime" minOccurs="0" maxOccurs="1"/>

<!--Extension point for custom headers-->

<xs:any processContents="lax" namespace="##other" minOccurs="0"

maxOccurs="unbounded" />

</xs:sequence>

</xs:complexType>

<!=-7.4.%2—eyr—CenfigurationReferen SEETeEEE
<xs:complexType name="ConfigurationReference">
<xs:seduence>

<!--7.4.2 d) DataChannellist structure-->
<xs:complexType name="DataChannelList">
<xs:sequence>

maxOccurs="lunbounded" />
</xs:sg¢quence>
</xs:complexType>

<!--7.4.2 e) DataChannel structure-->
<xs:complexType name="DataChannel">
<xs:sedquence>

maxOccurs=11"/>

<!--7.4.2 f) DataChannelID strucfure-->
<xs:complexType name="DataChannelID">
<xs:sequence>

<!--7.4.%2 g) ProOperty structure-->
<xs:complexIywe name="Property">
<xs:sequénce>

</xs:s¢quence>
</xs:complexType>

</xs:s¢quence>
</xs:complexType>

</xs:s¢quence>
</xs:complexType>

<xs:g¢lement name="ID" type="xs:string" minOccurs="1" maxOccurs="1"/>
<xs:¢lement name="TimeStamp" type="xs:dateTime" minOccurs="1" maxOccurss"1"/>

<!--7.4.2 e) DataChannel structure-->
<xs:g¢lement name="DataChannel" type="sdd:DataChannel" mifAOcCurs="1"

<!--7.4.2 f) DataChannellID structure-->
<xs:g¢lement name="DataChannelID" type="sdd®DataChannelID" minOccurs="1"

<!--7.4.2 g) Property structure-->
<xs:g¢lement name="Property" type="sddiProperty" minOccurs="1" maxOccurs="1"/>

<xs:g¢lement name="LocalID" type="xs:string" minOccurs="1" maxOccurs="1"/>
<xs:g¢lement name="ShodetyID" type="xs:string" minOccurs="0" maxOccurs="1"/>
<!--T7.4.2 m) NameOhjeet structure-->

<xs:g¢lement name="NameObject" type="sdd:NameObject" minOccurs="0" maxOccurs="1"/p

<!——% 333) Tdentifier of Data Channel ’I"n:\@' uch a raw numeric x;ﬂna'
average value, alarm and status, etc.-->
<xs:element name="DataChannelType" type="sdd:DataChannelType" minOccurs="1"

maxOccurs="1"/>

26

<!--5.3 b) Formats are for describing data formats-->
<!--Assumed data types are "Float","Integer","Boolean","Text" and "Symbol"-->
<xs:element name="Format" type="sdd:Format" minOccurs="1" maxOccurs="1"/>

<!--5.3 c) Range of measurement value-->

<xs:element name="Range" type="sdd:Range" minOccurs="0" maxOccurs="1"/>

<!--5.3 d) Unit and quantity of measurement value-->

<xs:element name="Unit" type="sdd:Unit" minOccurs="0" maxOccurs="1" />

<!--5.3 e) Name of data quality evaluation scheme-->

<xs:element name="QualityCoding" type="xs:string" minOccurs="0" maxOccurs="1"/>
<!--5.3 f) Names assigned in on-board control systems and other instruments-->
<xs:element name="Name" type="xs:string" minOccurs="0" maxOccurs="1"/>

<!--5.3 g) Remarks shall contains location, manufacturer and type of equipment-->

<xs:element name="Remarks" type="xs:string" minOccurs="0" maxOccurs="1"/>
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<!--Extension point for custom properties—-->
<xs:any processContents="lax" namespace="##other" minOccurs="0"
maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<!--7.4.2 h) DataChannelType structure-->
<!--5.3 a) Identifier of Data Channel Type, such as raw numeric value,
average value, alarm and status, etc.-->
<xs:complexType name="DataChannelType'">
<xs:sequence>
<xs:element name="Type" minOccurs="1" maxOccurs="1">
<xs:simpleType>

+ + L = 3 n

+
o= e o ot S-S RY

<xs:enumeration value="Inst"/>
<xs:enumeration value="Average"/>
<xs:enumeration value="Max"/>
<xs:enumeration value="Min"/>
<xs:enumeration value="StandardDeviation"/>
<xs:enumeration value="Calculated"/>
<xs:enumeration value="SetPoint"/>
<xs:enumeration value="Output"/>
<xs:enumeration value="Alert"/>
<xs:enumeration value="Status"/>
<xs:enumeration value="ManuallyInput"/>
</xs:restriction>
</xs:simpleType>

</xs:element>

<xs:element name="UpdateCycle" type="xs:decimal minOccurs="0" maxOccurs='1"/>

<xs:element name="CalculationPeriod" type="xs:decimal" minOccurs="0" maxOg¢curs="1"/>

/xs:sequence>

</ks:complexType>

<!'+-7.4.2 i) Format structure—-->
<!t-5.3 b) Format of measurement value—+4X
<xp:complexType name="Format">
Xs:sequence>
<!--Type of the Format-->
<xs:element name="Type" minO¢€urs="1" maxOccurs="1">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:enumeration_%@lue="Decimal"/>
<xs:enumeratipon_value="Integer"/>
<xs:enumeratiod value="Boolean"/>
<xs:enumeréation value="String"/>
</xs:restrietion>
</xs:simpl&lype>
</xs:elemert
<!=-=7.4.2(49)" Restriction of the value-->
<xs:element name="Restriction”" minOccurs="0" maxOccurs="1">
<xsdcomplexType>
KXs:choice maxOccurs="unbounded">
<xs:element name="Enumeration" type="xs:string" minOccurs="0"

maxOfelrs="unbounded" />
scelement name="FractionDigitg" Lype=" cinteger" minQcocurs="0"

maxOccurs="1"/>

<xs:element name="Length" type="xs:integer" minOccurs="0" maxOccurs="1"/>

<xs:element name="MaxExclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>

<xs:element name="MaxInclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>

<xs:element name="MaxLength" type="xs:integer" minOccurs="0" maxOccurs="1"/>

<xs:element name="MinExclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>

<xs:element name="MinInclusive" type="xs:decimal" minOccurs="0"
maxOccurs="1"/>

<xs:element name="MinLength" type="xs:integer" minOccurs="0" maxOccurs="1"/>

<xs:element name="Pattern" type="xs:string" minOccurs="0" maxOccurs="1"/>

<xs:element name="TotalDigits" type="xs:integer" minOccurs="0" maxOccurs="1"/>

<xs:element name="WhiteSpace" minOccurs="0" maxOccurs="1">

<xs:simpleType>
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<xs:restriction base="xs:string">
<xs:enumeration value="preserve"/>
<xs:enumeration value="replace"/>
<xs:enumeration value="collapse"/>
</xs:restriction>
</xs:simpleType>
</xs:element>
</xs:choice>
</xs:complexType>
</xs:element>
</xs:sequence>
</xs:complexType>

<!=-=7.4. 2——Renge—stractss

<!--5.3 ¢) Range of measurement value-->

<xs:complexType name="Range">
<xs:sedquence>

<!--Higher limit of measurement value-->
<xs:g¢lement name="High" type="sdd:emptyOrDecimal" minOccurs="1" maxOccurs="1"/>
<!--lower limit of measurement value-->

<xs:¢lement name="Low" type="sdd:emptyOrDecimal" minOccurs="1" maxQetdrs="1"/>
</xs:s¢quence>
</xs:complexType>

<!=-=-7.4.2 1) Unit structure-->
<!--5.3 d) Unit and quantity of measurement value-->
<xs:complexType name="Unit">

<xs:sedquence>

<!--%ymbol of the unit-->
<xs:g¢lement name="UnitSymbol" type="xs:string" minQegurs="1" maxOccurs="1"/>
<!--Quantity name of the measurement value, that As defined in IS080000 or Table? -->

<xs:¢lement name="QuantityName" type="xs:string!\minOccurs="0" maxOccurs="1"/>
<!--Fxtension point for custom Unit element, suc¢h as Quantity Symbol, Scale Factfor,
etc.-—>
<xs:4ny processContents="1lax" namespace="##other" minOccurs="0"
maxOccurs="lunbounded" />
</xs:s¢quence>
</xs:complexType>

<!--7.4.2 m) NameObject structure-->
<xs:complexType name="NameObject">
<xs:seduence>
<!--Name of NamingRule, see 5.2.3-->
<xs:g¢lement name ="NamingRulle" type="xs:string" minOccurs="1" maxOccurs="1"/>
<!--Fxtension point fox Gustom NameObjects, Definition of LocalDataName structure-->
<xs:4qny processContepnts="1lax" namespace="##other" minOccurs="0"
maxOccurs="lunbounded" />
</xs:sg¢quence>
</xs:complexType>

<!--empty value acceptable decimal-->
<xs:simpleTypeStframe="emptyOrDecimal">
<xs:unjonemberTypes="sdd:empty xs:decimal"/>
</xs:simplE&Type>
<XS: sj_mp o"l"fl pe ham@:"ompfi "
<xs:restriction base="xs:string">
<xs:enumeration value=""/>
</xs:restriction>
</xs:simpleType>
</xs:schema>

c¢) XML representation

This example uses namespace:nr for custom elements. Custom elements are written in Italic for
reference.

<?xml version="1.0" encoding="utf-8"?>
<Package xmlns="urn:I1S019848:SHIP DATA DEFINITION"
xmlns:nr="urn:15019848:SHIP DATA DEFINITION:NAMING RULE">
<Header>
<ShipID>IMO1234567</ShipID>
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<DataChannelListID>
<ID>DataChannellList.xml</ID>
<TimeStamp>2016-01-01T00:00:00Z</TimeStamp>
</DataChannellistID>
<Author>Authorl</Author>
<DateCreated>2015-12-01T00:00:00+00:00</DateCreated>
<nr:CustomHeaderElement>Vender specific headers</nr:CustomHeaderElement>
</Header>
<DataChannelList>
<DataChannel>
<DataChannelID>
<LocalID>/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Temp
</LocallD>
Sheretb>000</Shertethb
<NameObject>
<NamingRule>Naming rule</NamingRule>
<nr:CustomNameObject>Vender specific NameObject</nr:CustomNameObjeect>
</NameObject>
</DataChannelID>
<Property>
<DataChannelType>
<Type>Inst</Type>
<UpdateCycle>1</UpdateCycle>
</DataChannelType>
<Format>
<Type>Decimal</Type>
<Restriction>
<FractionDigits>1</FractionDigits>
<MaxInclusive>200.0</MaxInclusive>
<MinInclusive>-150.0</MinInclusive>
</Restriction>
</Format>
<Range>
<High>150.0</High>
<Low>0.0</Low>
</Range>
<Unit>
<UnifSymbol>°C</UnitSymbol>
<QuantityName>Temperature</QuantityName>
</Unit>
<QualityCoding>0PC_QUALITY</QualityCoding>
<Name>M/E #1 Air Cooler CFW OUT Temp</Name>
<Remarks> Locations ECR, Manufacturer: AAA Company, Type: TYPE-AAA </Renjarks>
<nr:CustomPropertyBlement>Vender specific Property</nr:CustomPropertyElement>
</Property>
/DataChannel>
DataChannel>
<DataChanneliD>
<LocalI>/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Prgss
</LofallD>
<ShérpID>0020</ShortID>
<NameObject>
<NamingRule>Naming Rule</NamingRule>
<nr:CustomNameObject>Vender specific NameObject</nr:CustomNameObject>
NameQhiect
</DataChannelID>
<Property>
<DataChannelType>
<Type>Average</Type>
<UpdateCycle>60</UpdateCycle>
<CalculationPeriod>3600</CalculationPeriod>
</DataChannelType>
<Format>
<Type>Integer</Type>
<Restriction>
<FractionDigits>1</FractionDigits>
<MaxInclusive>200.0</MaxInclusive>
<MinInclusive>-150.0</MinInclusive>
</Restriction>
</Format>
<Range>
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<High>150.0</High>
<Low>0.0</Low>

</Range>

<Unit>

<UnitSymbol>°C</UnitSymbol>

<QuantityName>Temperature</QuantityName>

</Unit>

<QualityCoding>0OPC QUALITY</QualityCoding>

<Name> M/E #1 Air Cooler CFW OUT Average Temp </Name>

<Remarks> Location:

ECR, Manufacturer: AAA Company, Type: TYPE-AAA </Remarks>

<nr:CustomPropertyElement>Vender specific Property</nr:CustomPropertyElement>
</Property>
</DataChannel>

<DataCk

|

<Datd
<L
</LocallID>
<SH
<N{

</N
</Daf
<Proj
<D4g

</]
<F

</1
<Q

<N4g

<Rqg

<n}
</Pr
</Data

<DataC}

<Datd
<L
</LocallID>

<SH

<N{

</N
</Daf
<Proj
<D4g

ChannelID>
calID>/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Temp/iAleT]

ortID>0011</ShortID>
meObject>
NamingRule>Naming Rule</NamingRule>
nr:CustomNameObject>Vender specific NameObject</nr:CustomNameOhjéect>
ameObject>
aChannelID>
erty>
taChannelType>
Type>Alert</Type>
ataChannelType>
rmat>
Type>String</Type>
Restriction>
<Enumeration>High</Enumeration>
<Enumeration>Low</Enumeration>
<Enumeration>Normal</Enumeration>
/Restriction>
ormat>
alityCoding>0OPC QUALITY</QualityCoging>
me> M/E #1 Air Cooler CFW OUT TempoStatus </Name>
marks> Location: ECR, Manufacturer: AAA Company, Type: TYPE-AAA </Remarks>
F: CustomPropertyElement>Vendex\sSpecific Property</nr:CustomPropertyElement>
perty>
hannel>
annel>
ChannelID>
calID>/Naming Rule/MaihEngine/AirCoolerl/CoolingFreshWater/Outlet/Press/Ale

ortID>0021</Shori=hHD>

meObject>

NamingRule>Namifig Rule</NamingRule>

nr:CustomNgmeObject>Vender specific NameObject</nr:CustomNameObject>
ameObject®

aChannel ID>

erty>

tahanhelType>

Type>Alert</Type>

</

o

at2ChannelT e

<Format>
<Type>String</Type>
<Restriction>

<Enumeration>High</Enumeration>
<Enumeration>Low</Enumeration>
<Enumeration>Normal</Enumeration>

</Restriction>
</Format>
<QualityCoding>0OPC QUALITY</QualityCoding>
<Name> M/E #1 Air Cooler CFW OUT Press Status </Name>

<Remarks> Location:

ECR, Manufacturer: AAA Company, Type: TYPE-AAA </Remarks>

<nr:CustomPropertyElement>Vender specific Property</nr:CustomPropertyElement>
</Property>
</DataChannel>
</DataChannellList>
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</Package>

A2.4

Time Series Data

a) Namespace

In Time Series Data, the following Namespace shall be added.

XMLNamespace:sdt=urn:IS019848:Ship_Data_Transport

b) XML Schema

ata structures in 7.5 shall be defined and validated by using following XML Schema.

<?xmfl version="1.0" encoding="utf-8"?>
<xs:pchema xmlns:sdt="urn:15019848:SHIP DATA TRANSPORT"

attributeFormDefault="unqualzﬁed"_elementFormDefault="qualiﬁed"
targetNamespace="urn:15019848:SHIP DATA TRANSPORT"
xmlns:xs="http://www.w3.0rg/2001/XMLSchema">

<!t+-8.4.2(1) Package structure-->

<xXp

:element name="Package" type="sdt:Package"/>

<!+-8.4.2(1) Package structure-->

<xB

:complexType name="Package">

Xs:sequence>

<!--8.4.2(2) Header structure-->

<xs:element name="Header" type="sdt:Header"
minOccurs="0" maxOccurs="1"/>

<!--8.4.2(5) TimeSeriesData structure -->

<xs:element name="TimeSeriesData" type="§dt:TimeSeriesData"
minOccurs="1" maxOccurs="uftbounded" />

/xs:sequence>

</ks:complexType>

<!t+-8.4.2(2) Header structure-->

<xB

:complexType name="Header">
Xs:sequence>
<!--IMO Number, HIN or other ship's identification number-->
<xs:element name="ShiplID% type="xs:string"
minOccurg=Y1" maxOccurs="1"/>
<!--8.4.2(3) TimeSpan~structure-->
<xs:element namex“IImeSpan" type="sdt:TimeSpan"
min®cctrs="0" maxOccurs="1"/>
<!--Date when.data are created-->
<xs:element~ame="DateCreated" type="xs:dateTime"
minOccurs="0" maxOccurs="1"/>
<!--Date.when data are modified-->
<xs:elfment name="DateModified" type="xs:dateTime"
minOccurs="0" maxOccurs="1"/>
<!lS=Author of data-->
<{Rglelement name="Author" type="xs:string"
minOccurs="0" maxOccurs="1"/>

<I--8.4.2(4) Reference to system configuration -->

<xs:element name="SystemConfiguration" type="sdt:ConfigurationReference"
minOccurs="0" maxOccurs="unbounded" />

<!--Extension point for custom headers-->

<xs:any processContents="lax" namespace="##other" minOccurs="0"

maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<!--8.4.2(3) TimeSpan structure-->
<xs:complexType name="TimeSpan">
<xs:sequence>

<!--TimeStamp of the oldest DataSet-->

<xs:element name="Start" type="xs:dateTime" minOccurs="1" maxOccurs="1"/>

<!--TimeStanp of the newest DataSet-->
<xs:element name="End" type="xs:dateTime" minOccurs="1" maxOccurs="1"/>

</xs:sequence>
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</xs:complexType>

<!--8.4.2(4) ConfigurationReference structure-->
<xs:complexType name="ConfigurationReference">
<xs:sequence>
<xs:element name="ID" type="xs:string" minOccurs="1" maxOccurs="1"/>
<xs:element name="TimeStamp" type="xs:dateTime" minOccurs="1" maxOccurs="1"/>
</xs:sequence>
</xs:complexType>

<!--DataChannelID structure-->
<!--Value must be Local ID or Shor ID strings. see 6.1 for the details.-->
<xs:complexType name="DataChannelID">
<Xs:simpptecentent
<xs:¢xtension base="xs:string">
<!4-Ordinal number of the DataChannelID array-->
<xg:attribute name="id" type="xs:positivelnteger" use="required" />
</xs{extension>
</xs:simpleContent>
</xs:complexType>

<!--8.4.2(5) TimeSeriesData structure -->
<xs:complexType name="TimeSeriesData">
<xs:sequence>
<!--8.4.2(4) ConfigurationReference structure -->
<xs:g¢lement name="DataConfiguration" type="sdt:ConfiguratiofiReference"
minOccurs="0" maxOccurs="1" />
<!--4.4.2(6) TabularData structure -->
<xs:g¢lement name="TabularData" type="sdt:TabularData
minOccurs="0" maxOccurs="unbounded" />
<!--%.4.2(7) EventData structure -->
<xs:g¢lement name="EventData" type="sdt:EventDaté"
minOccurs="0" maxOccurs="1" />
<!--Extension point for custom data kinds--3
<xs:4ny processContents="1lax" namespace="##other" minOccurs="0"
maxOccurs="lunbounded" />
</xs:s¢quence>
</xs:complexType>

<!--8.4.2(6) TabularData structure -->
<xs:complexType name="TabularData'>
<xs:sequence>
<!--Number of DataSet elements under the hierarchy -->
<xs:g¢lement name="NumberOfDataSet" type="xs:nonNegativeInteger"
minOccurs="0" ‘maxOccurs="1" />
<!--Number of DataChabnels for each DataSources-->
<xs:¢lement name="NumberOfDataChannel" type="xs:nonNegativelInteger"
minOcCurs="0" maxOccurs="1"/>
<!--8.4.2(6) Idéntifiers of target DataChannels-->
<xs:¢lement name="DataChannelID" type="sdt:DataChannelID"
minOccurs="0" maxOccurs="unbounded" />
<!--8.4.2(8)y"DataSet structure -->
<xs:g¢lement name="DataSet" type="sdt:DataSet Tabular"
minOccurs="0" maxOccurs="unbounded" />

</xs:sdqrénce
</xs:complexType>

<!--8.4.2(7) EventData structure -->
<xs:complexType name="EventData">
<xs:sequence>
<!--Number of DataSet elements under the hierarchy -->
<xs:element name="NumberOfDataSet" type="xs:nonNegativeInteger"
minOccurs="0" maxOccurs="1" />
<!--8.4.2(9) DataSet structure -->
<xs:element name="DataSet" type="sdt:DataSet Event"
minOccurs="0" maxOccurs="unbounded" />
</xs:sequence>
</xs:complexType>

<!--8.4.2(8) DataSet structure for Tabular Data -->
<xs:complexType name="DataSet Tabular">
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<xs:sequence>
<!--Measurement value -->
<!--Measurement value can be empty-->
<xs:element name="Value" type="sdt:Value"
minOccurs="1" maxOccurs="unbounded"/>
</xs:sequence>
<!--IS0 8601 date & time structure shall be used-->
<xs:attribute name="timeStamp" type="xs:dateTime" use="required"/>
</xs:complexType>

<!--8.4.2(9) DataSet structure for Event Data-->
<xs:complexType name="DataSet Event">
<xs:sequence>

1 m £ m | B nY 1 fal™ 1 ITnn 1= |} 1= 2 LLJ
+ re—he betatherrettb e Ca—a—ro oo
minOccurs="1" maxOccurs="1"/>
<!--Measurement value -->

<!--Measurement value can be empty-->
<xs:element name="Value" type="xs:string"
minOccurs="1" maxOccurs="1"/>
/xs:sequence>
!--ISO 8601 date & time structure shall be used-->
xs:attribute name="timeStamp" type="xs:dateTime" use="required"/>

xs:attribute name="quality" type="xs:string" use="optional®¥/>
</ks:complexType>

<!t-Value structure for Tabular Data -->
<xp:complexType name="Value'">
xs:simpleContent>
<xs:extension base="xs:string">
<!--Ordinal number of the Value array.
Order of the array shall be the same as(TabularData/DataChannellID array]-->
<xs:attribute name="ref" type="xs:positiveInteger" use="required" />
<xs:attribute name="quality" type="{s:string" use="optional"/>
</xs:extension>
/xs:simpleContent>
</ks:complexType>
</xsfschema>

c) XML representation

Example of XML representation is as follows.

<?xmfl version="1.0" encodirig="utf-8" 2>
<Package xmlns="urn:I1SQ19848:SHIP DATA TRANSPORT">
<Hgader>
ShipID>IMO12345%7</ShipID>
TimeSpan>
<Start>20¥6=01-01T12:00:00z</Start>
<End>2016-01-03T12:00:00z</End>
/TimeSpan>
DateCreated>2016-01-03T12:00:002</DateCreated>
DakeModified>2016-01-03T12:00:00Z</DateModified>
Awthor>Shipboard data server</Author>
SystemConfiguratTon
<ID>SystemConfiguration.xml</ID>
<TimeStamp>2016-01-01T00:00:00Z</TimeStamp>
</SystemConfiguration>
<SystemConfiguration>
<ID>SystemConfiguration.xml</ID>
<TimeStamp>2016-01-03T00:00:00Z</TimeStamp>
</SystemConfiguration>
</Header>
<TimeSeriesData>
<DataConfiguration>
<ID>DataChannellist.xml</ID>
<TimeStamp>2016-01-01T00:00:00Z</TimeStamp>
</DataConfiguration>
<TabularData>
<NumberOfDataSet>2</NumberOfDataSet>
<NumberOfDataChannel>2</NumberOfDataChannel>
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<!--ShortID of the DataChannel -->

<DataChannelID id="1">0010</DataChannelID>
<DataChannelID id="2">0020</DataChannelID>
<DataSet timeStamp="2016-01-01T12:00:002">

<!--TabularData/DataSet/Value@Rref references TabularData/DataChannelID@id -->

<!--measurement value of Data Channel:0010 at 2016-01-

<Value ref="1" quality="0">100.0</Value>

<!--measurement value of Data Channel:0020 at 2016-01-

<Value ref="2" quality="0">200.0</Value>
</DataSet>
<DataSet timeStamp="2016-01-02T12:00:002">

<!--measurement value of Data Channel:0010 at 2016-01-

<Value ref="1" quality="0">100.5</Value>

<! eSS e e et Do S e O

01T12:00:00Z2 -->

01T12:00:00Z -->

02T12:00:00Z -->

Q2m1 2 . 00 . 007

<V4lue ref="2" quality="0">205.0</Value>
</DafaSet>
</TabularData>
<Tabuld4rData>
<NumlperOfDataSet>3</NumberOfDataSet>
<NumpperOfDataChannel>1</NumberOfDataChannel>
<Dat4ChannelID id="1">0010</DataChannelID>
<DatgSet timeStamp="2016-01-01T12:00:002">
<V4lue ref="1" quality="0">100.0</Value>
</DafaSet>
<DatgSet timeStamp="2016-01-02T00:00:002Z">
<Vglue ref="1" quality="0">100.2</Value>
</DafaSet>
<DatgSet timeStamp="2016-01-02T12:00:002">
<V4lue ref="1" quality="0">100.5</Value>
</DafaSet>
</TabularData>
<EventDhata>
<NumpperOfDataSet>3</NumberOfDataSet>
<DatgSet timeStamp="2016-01-01T12:00:012" quality="0">
<DgtaChannelID>0011</DataChannelID>
<Value>HIGH</Value>
</DafaSet>
<DatgSet timeStamp="2016-01-01T12:00<01Z2" quality="0">
<DgtaChannelID>0021</DataChanneliB>
<Value>HIGH</Value>
</DafaSet>
<DatgSet timeStamp="2016-01-03T12:00:232" quality="0">
<DgtaChannelID>0011</DataChannelID>
<Vglue>NORMAL</Value>
</DafaSet>
</EventData>
</TimeSefiesData>
<TimeSerjlesData>

<DataC
<ID>]
<Timg

nfiguration#®
ataChannelhist.xml</ID>
Stamp>2Q16-01-03T00:00:00Z</TimeStamp>

</DataConfigufation>

<TabularData>
<Numbpe?QfDataSet>1</NumberOfDataSet>
<NumherQfDataChannel>2</NumberQfDataChannel

<DataChannelID id="1">0010</DataChannelID>
<DataChannelID id="2">0020</DataChannelID>
<DataSet timeStamp="2016-01-03T12:00:002">
<Value ref="1" quality="0">101.0</Value>
<Value ref="2" quality="0">210.0</Value>
</DataSet>
</TabularData>
<TabularData>
<NumberOfDataSet>2</NumberOfDataSet>
<NumberOfDataChannel>1</NumberOfDataChannel>
<DataChannelID id="1">0010</DataChannelID>
<DataSet timeStamp="2016-01-03T00:00:002">
<Value ref="1" quality="0">100.8</Value>
</DataSet>
<DataSet timeStamp="2016-01-03T12:00:002">
<Value ref="1" quality="0">101.0</Value>
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</DataSet>

</TabularData>
</TimeSeriesData>
</Package>

NOTE This example shows that both system configurations and Data Channel List are
2016-01-03T00:00:00Z, therefore this example has two Time Series Data elements. Further, Data Channel 0010,
0020 have 24 hour update interval and 0110 have 12 hour update interval. Therefore this example has two
TabularData elements for each TimeSeriesData element.

A3

A.3.1
This
JSON|

|

A.3.7
JSON

II/N

JSON implementation

modified at

General
clause defines the way to describe the data by using JSON.
implementation is not mandatory but shall be implemented in accordancewith the fo
xtension of the file shall be “json”.
Any newline or indent characters in the file shall not be treated as.significant informat

(ML element with namespace shall convert to JSON element as it is. For exa
lement>Value</xml:Element> is converted to { "xml:Element" : "Value" }.

Data Channel List

representation example is given below.

Package": {
"Header": {
"ShipID": "IMO1234567",
"DataChannelListID": {
"ID": "DataChannelListoxml",
"TimeStamp": "2016-01-01T00:00:00Z"
o

"Author": "Authorl"s
"DateCreated": "2Q0@15-12-01T00:00:002",
"nr:CustomHeaderElement": "Vender specific headers"

br
"DataChannelLigEMy” {

"DataChanpeN": [{

"DataChahnelID": {
"1L.OoCalID":

hming Rulé/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Temp",
"ShortID": "0010",
"NameObject": {

"NamingRule": "Naming Rule",

"nr:CustomNameObject": "Vender specific NameObject"

1

lowing.

on.

mple, <xml:

© ISO

by
"Property": {
"DataChannelType": {
"Type": "Inst",
"UpdateCycle": "1"
b
"Format": {
"Type": "Decimal",
"Restriction": {
"FractionDigits": "1",
"MaxInclusive": "200.0",
"MinInclusive": "-150.0"
}
b
"Range": {
"High": "150.0",

2018 - All rights reserved
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"Low":
by
"Unit": {
"UnitSymbol": "°C",
"QuantityName":
b
"QualityCoding":
"Name" :
"Remarks": "

"o.o"

Location:

}
boo A
"DataChannelID": {

nr 1T

"Temperature"

"OPC QUALITY",
"M/E #1 Air Cooler CFW OUT Temp",

ECR, Manufacturer:
"nr:CustomPropertyElement":

AAA Company,
"Vender specific Property"

Type: TYPE-AAA ",

"/Naming R
"ShortID": "0020",
"NameObject": {

"NamingRule":

}
by
"Property": {
"DataChannelType": {
"Type": "Average",
"UpdateCycle": "60",
"CalculationPeriod":
b
"Format": {
"Type": "Integer",
"Restriction": {
"FractionDigits":
"MaxInclusive":
"MinInclusive":
}
b
"Range": {
"High":
"Low":

"150.0",
"O'O"

s

MTUnit": |

"UnitSymbol": "°C",

"QuantityName": "Temp!"

[

"Name" :

"Remarks": "Chocation:

}

¥ I

"DataChapnelID": {
"LQoeallID":

"/Naming R

YShortID": "0011",

"NameObject": ({

"NamingRule":

"Naming

le/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Press",

"Naming Rule",
"nr:CustomNameObject": "Vender specific NameObject"

"200.0",
"-150.0"

’
QualityCoding": "OPC\QUALITY",
" M/E (#)°Air Cooler CFW OUT Average Temp ",

ECR, Manufacturer:
"nr:CustonfPxepertyElement":

le/MafniEngine/AirCoolerl/CoolingFreshWater/Outlet/Temp/Alert",

"3I600"

"l",

AAA Company,
"Vender specific Property"

Type: TYPE-AAA "|,

Rule",

"nr:CustomNameObject"T "Vender specific NameObject"

}

}o

"Property": {
"DataChannelType": {

"Type": "Alert"
by
"Format": {
"Type": "String",
"Restriction": {
"Enumeration": [

"High",
HLOWH,
"Normal"

36

© ISO 2018 - All rights reserved


https://standardsiso.com/api/?name=3564da8819ed6e03e525990efb167d84

ISO 19848:2018(E)

b

"QualityCoding": "OPC QUALITY",
"Name": " M/E #1 Air Cooler CFW OUT Temp Status ",
"Remarks": " Location: ECR, Manufacturer: AAA Company, Type: TYPE-AAA ",
"nr:CustomPropertyElement": '"Vender specific Property"

}
boo A
"DataChannelID": {

"LocalID":
"/Naming Rule/MainEngine/AirCoolerl/CoolingFreshWater/Outlet/Press/Alert",
"ShortID": "0021",
"NameObject": {
"NamingRule": "Naming Rule",
"1.;.._ = = = W f‘\L-\J' #'YT "TV “d e + _‘:ﬁ I\Tum f\L\J’ =10

}
by
"Property": {
"DataChannelType": {

"Type": "Alert"
by
"Format": {
"Type": "String",
"Restriction": {
"Enumeration": [
"Highll ,
"LOWH ,
"Normal"
]
}
br
"QualityCoding": "OPC QUALITY",
"Name": " M/E #1 Air Cooler CEW(OUT Press Status ",
"Remarks": " Location: ECR, Mantufacturer: AAA Company, Type: TYBE-AAA ",
"nr:CustomPropertyElement'" :5>"%ender specific Property"
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A.3.3 Time Series Data

Example of JSON representation is as follows.

{
"Package": {
"Header": {
"ShipID": "IMO1234567",
"TimeSpan": {
"Start": "2016-01-01T12:00:002",
"End": "2016-01-03T12:00:00z2"
b
"DateCreated": "2016-01-03T12:00:002",
"DPateModified": "2016-01-03T12:00:00z",
"Author": "Shipboard data server",
"$ystemConfiguration”: [{
"ID": "SystemConfiguration.xml",
"TimeStamp": "2016-01-01T00:00:002"
I I
"ID": " SystemConfiguration.xml ",
"TimeStamp": "2016-01-03T00:00:002"
H]
bo
"Tim¢SeriesData": [{
"DbataConfiguration": {
"ID": "DataChannelList.xml",
"TimeStamp": "2016-01-01T00:00:00Z "
}
"TabularData": [{
"NumberOfDataSet": "2",
"NumberOfDataChannel": "2",
"DataChannelID": ["0010", "0020"],
"DataSet": [{

"TimeStamp": "2016-01-01T12:00:002%;
"Value": [ "100.0"™, "200.0" J%
"QualityH: [HOH’ "O"]

boo A

"TimeStamp": "2016-01-02T1Z:00:002",
"Value": [ "100.5", "2Q%.0" 1],
"QualityH: [HOH’ "O"]

}]

oA
"NumberOfDataSet": ("3
"NumberOfDataChanael™: "1",
"DataChannelID"s N\ *0110"],
"DataSet": [{

"TimeStamp"™y "2016-01-01T12:00:00z",
"Valwe': [ "100.0"™ ],

"Quadity": ["0"]
b Ao
"TimeStamp": "2016-01-02T00:00:002",
"Value": [ "100.2" ],
"Quality": ["0"]
) 1
"TimeStamp™: "Z01o-01-0Z2TI1Z2:00:00Z27,
"Value": [ "100.3" ],
"Quality": ["0"]
H
Pl
"EventData": {
"NumberOfDataSet": "3",
"DataSet": [{
"TimeStamp": "2016-01-01T12:00:01z2",
"DataChannelID": "0011",
"Value": "HIGH",
"Quality": "O"
boo A
"TimeStamp": "2016-01-01T12:00:012",
"DataChannelID": "0021",
"Value": "HIGH",
"Quality": "O"
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boo A
"TimeStamp": "2016-01-01T12:00:232",
"DataChannelID": "0011",
"Value": "NORMAL",
"Quality": "O"
H
}
boo A
"DataConfiguration": {
"ID": "DataChannelList.xml",
"TimeStamp": "2016-01-03T00:00:00z"
bo

"TabularData": [{
"I\“[Mmb % fDM+MC +|'. lllll,
"NumberOfDataChannel": "2",
"DataChannelID": ["0010", "0020"],
"DataSet": [{

"TimeStamp": "2016-01-03T12:00:00Z2 ",
"Value": [ "101.0", "210.0" 7,

"Quality": ["O"’ "O"J
H]
P A
"NumberOfDataSet": "2",
"NumberOfDataChannel": "1",
"DataChannelID": ["0110"],

"DataSet": [{
"TimeStamp": "2016-01-03T00:00:002",
"Value": ["100.8"],
"Quality": ["0"]
b A
"TimeStamp": "2016-01-03T12:00:00%,

"Value": [ "101.0" ],
"Quality": ["O0"]
3]
H
H
}
}
NOTH Same as XML implementationy-this example shows that both system configuration and Pata Channel

List dre modified at 2016-01-03T00:00:00Z. Therefore, this example has two Time Series Data elempnts. Further,
Data |Channel 0010, 0020 have 24=hour update interval and 0110 have 12-hour update interval. Therefore, this
examjple has two TabularData elements for each TimeSeriesData element.

A.4 | CSVimplementation

A.4.1 General

This|clause défines the way to describe the data by using CSV. CSV is only available for Timg Series Data
and ghall bexused in combination with Data Channel List described in XML/JSON.

CSV shall be implemented in accordance with the following.

— CSV shall be described in accordance with RFC 4180.

— Extension of the file shall be “csv”.

— Tabular Data and Event Data shall be described separately.
— (CSV shall have the same number of columns in all rows.

— Header row (1st row) may be omitted when Data Channel in the data can clearly identified. This
definition will be described in Alias List on ISO 19847.

A.4.2 Tabular Data

CSV describes Tabular Data as follows:
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TimeStamp, DataChannellID 1, DataChannellID 2, ey DataChannellID N
TimeStamp 1, Value 1-1, Value-1-2, ey
. ey ey ey
TimeStamp M, ey ey ey Value M-N
where
TimeStamp_M is the measurement date and time;

DataChqnnellD_N is the one of the following: Universal ID, Local ID, Short ID;

Value_M-N is the measurement value of DataChannelID_N at TimeStamp_M

Example of LSV for Tabular Data by using Short ID is as follows:

TimeStamp, 0010, 0020

2016-01-Q1T12:00:00%Z, 100.0, 200.0
2016-01-Q2T12:00:00%Z, 100.5, 205.0
2016-01-(Q3T12:00:00%Z, 101.0, 210.0

where 0010] 0020 is the Short ID of some Data Channel.

A4.3 Evient Data

CSV describgs Event Data as follows:

TimeStamy, DataChannelID, Value
TimeStamp 1, DataChannelID/ 1y Value 1-1
ey ey
TimeStamp M, DataChafin€lID N, Value M-N
where

TimeStdmp_M i9 the measurement date and time;

DataChqnnellD_IN is the one of the following: Universal ID, Local ID, Short ID;

Value_M-N is the measurement value of DataChannellD_N at TimeStamp_M.

Example of CSV for Event Data by using Short ID is as follows:

TimeStamp, DataChannellID, Value
2016-01-01T12:00:01z,0011, HIGH
2016-01-01T12:00:01z,0021, HIGH
2016-01-01T12:01:23Z,0011, NORMAL

where 0011, 0021 is the Short ID of some Data Channel.
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Annex B
(informative)

Examples of Local ID definitions — jsmea_mac

B.1 Naming Rule

Loca| ID shall be named in accordance with rules that are unified respectively in each Namfng Rule.

As an example of jsmea_mac Naming Rule, a method of naming Local ID by dividing Data into five Name

Objefts and combining these IDs is introduced.
Detajls of Name Object are shown in Table B.1.
Table B.1 — List of Categories
Ngme Object Description & ~ Example
MainEngine,
System Discrete equipment, systems, and units. DieselGenerdtorSet
CoolingSeaWaterSystem
Cylinder
Component Part of the System above or detail-description of the system. TurboChargdr
FuelOilLine
HeavyFuelOil
Contlnt Contents that flow throtugh pipelines or parts in the above CoolingFrest{Water
component.
ExahstGas
Inlet
Posikion Position that)indicates relative positions in System and Com- Outlet
ponents:
Port
Temp
Indicates temperatures, pressures and other measurement
[tem)| Y Press
objects.
Speed
Only if Data Channels cannot be specified with the Elements Modifier is typically used
shown above (from “System” to “Item”), suffix may be added to describe cprrection
Suffix after Local ID to identify the Data Channels. parameter such as tem-
Option : : perature for tuel oil vis-
(Option) Suffix may consists of and DataChannelType as shown below. cosity, like "at15degC" .
Suffix: ../<modifier>/<DataChannelType>

» o«

According to the categorising and naming rules defined by “jsmea_mac”, “Main Engine #3 Air Cooler
Cooling Fresh Water Outlet Temperature” for the ship whose IMO number is “IM01234567” is as follows.

Local Data Name

ShipID Naming Rule =
System Component Content Position | Item

IM01234567 jsmea_mac MainEngine |AirCooler3 CoolingFreshWater Outlet Temp

In this case, the <Universal ID> and <Local ID> are as follows.
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<Universal ID> = http://IM01234567/jsmea_mac/MainEngine/AirCooler3/CoolingFreshWater/Outlet/
Temp//Inst

<Local ID> = /jsmea_mac/MainEngine/AirCooler3/CoolingFreshWater/Outlet/ Temp//Inst

B.2 Name Object

When writing Local ID structure in Data Channel List, Name Object is added under Data Channel
element.

Figure B.1 shows an example of adding Name Object in “jsmea_mac”. In this example, three attributes

—ID COde nd Nama ara addad e dar Nayaa Olbhdact o daceriha darailc
y He—rae S et aHHaerrvaHe-oBje et aeSerBe-aetaits

Package

1 Header

DataChannelList

DataChannel

0.*

Property

NameObject

NamingRule : String
jm:System : jm:System
jm:Component : jm:Component
jm:Content : jm:Content:

1 jm:Position: jm:Position,
jm:Item : jm:Item

jm:Suffix : jm:Suffix

jm:System

ID : String
Code : String
Name : String

Vi

jm:Component

ID : String
Code : String
Name : String

V.

jm:Content

ID : String
Code : String
Name : String

V.

jm:Position

ID : String
Code : String
Name : String

Vi

jm:Item

ID : String
Code : String
Name : String

Vi

jm:Suffix

I L O e

Vi

ID : String
Code : String
Name : String

Figure B.1 — Logical structure of Data Channel List to which Name Object is added
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Codebook s alist of standard names that corresponds to Name Object, and created for each Name Object.

In codebook: ID, which is part of Local ID; Code, machine-friendly name that corresponds to the ID;
Name, that is for human readability; and its description are described.

EXAMPLE
ID Code Name Description
MainEngine 1IMEO1 No.1 Main Engine No. 1 Diesel engine for propulsion
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Annex C
(informative)

Examples of LocallD definitions — DNVGL-VIS

C.1 General

The require
provided at

ments regarding construction and contents of Local IDs under the DNVGL-VIS naming+
data.dnvgl.com/dnvgl-vis. The purpose of this informative Annex is to provide explan

information|

C.2 DNV{

VIS is an alf
tools for clg
equipment,
Decimal Cla
available at

and examples to assist implementers.

rL-VIS introduction

breviation for Vessel Information Systems, which has been used”in DNV GL produ

ule is
htory

ction

ssification of vessels since 2005. VIS contains a hierarchy offunctions and libraries of

where a name and code is defined for each item. The coding is based on the Uniy|
ksification (UDC) numbering system. The DNVGL-VIS is fufther described in document
data.dnvgl.com/dnvgl-vis.

C.3 Loca

| ID construction

C.3.1 Overall Local ID composition

When DNV(Q

Local ID =F
many) deno

The naming
group shall

Example of
— 411.1/C
— Propuls
NOTE Fy

In order to

L-VIS is used as naming rule, the LocaklP shall be constructed as follows:

inction group/n*Sub-Function group/Suffix and quantity group, where n is an integer
Fing how many times the Sub-Funetion group is repeated.

elements within each group shall be separated by a plus character (“+”), whereas
be separated by a slash character (“/”).

.ocal ID using DNVGL-VIS:

101.31+2/ExhaustGasOut+t(C) (Coded version)
ionEngine/CylinderArrangement+No2/ExhaustGasOut+t(C) (Verbose version)
rther.explanation of this and other examples are provided in C.4. below.

hvoid ambiguities for parser implementations, any space, plus or slash characters fou

ersal
htion

(Oto

each

nd in

the naming elements sources (DNVGL-VIS or IS0 80000) shall be replaced by underscore character
before constructing the Local ID.

C.3.2 Naming Elements groups

Three different Naming Elements groups are defined in the following:

a) Function group

Function group = <Function>+<Component>+<Location>

(")

The Function group is mandatory and must start with one Function. The Component shall not
be included if a Sub-Function group is appended. (This is because the same Component will be
provided with the Sub-function at the next, and is thus redundant.) Although optional, it is highly
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recommended that Location is used to separate between multiple instances of the given Function/

Component pair, when applicable.
b) Sub-Function group

Sub-Function group = <Sub-function>+<Component>+<Location>

0 to n Sub-Function groups can be appended to the Function group. Each Sub-Function group must
start with a Sub-Function. The Component is optional and may only be included in the last Sub-

Function group. Although optional, it is highly recommended that Location is used

to separate

between multiple instances of the given Sub-Function/Component pair, when applicable.

c) $uffix and quantity group

$uffix and quantity group = <Suffix>+<Quantity>(<UoM>)

.

[he Suffix and quantity group is mandatory, but the individual elements'(Suffix, Quanti
optional. This implies that at least one of the elements must be used. The implementer
that the Suffix and quantity group is constructed so that unique Local IDs are created.

The different Naming Elements that can be used to construct the above Naming Element
been|further explained in Table C.1 below.

Table C.1 — Table C.1: Naming Elemeénts used in DNVGL-VIS

Lomponents assigned to a Function or Sub-Function can only be selected from thosedefined in VIS.

[ty, UoM) are
must ensure

broups have

Naming Element Description/Example

Functions represent the ability to perform or prevent certain actions by p
sel. Functions are defined Jierarchically. Function leaves may be assigned
The allowed Functions values are defined in “DNVGL-VIS Functions”. Ex
(Propulsion driver), 51¢/(Main electric power system)

Fungtion

arts of a ves-
Components.
imples: 411.1

Components are physical items that may exist on-board vessels. Componer]
ized according te “Disciplines” defined in “DNVGL-VIS Disciplines”. Com
Component provide a detailed description through sub-functions, which again mayj
Components. The allowed Component values are defined in “DNVGL-VIS
Examples:'C221 (Shaft), C101 (Reciprocating internal combustion engine), N52 ((

tsare organ-
bonents may
be assigned
Equipment”.
kyro compass)

Locations refer to positions on-board a vessel. Three types of Locations|
absolute, generic and relative. The allowed Location values are defined inl
Locations”. Location may be omitted if not needed to identify the Function or
group, e.g. if there is only one instance on-board. Examples: S (Starboard),

Locdtion

are defined;
“DNVGL-VIS
Sub-Function
P (Port), 1,2,9

Sub-Functions express the ability to perform or prevent actions applic3

ble by parts

of a Component. Sub-functions are defined hierarchically. Sub-function l¢aves may be
Sub-Function assigned Components. The allowed Sub-function values are defined in[“DNVGL-VIS
Equipment”. Examples: C101.31 (Cylinder arrangement in a Reciprocating |nternal com-
bustion engine), E15.3 (Transformer in a Shore Connection)
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